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IP Softphone 2050 overview

The IP Softphone 2050 turns your computer into a telephone. To make a 
call, you dial with your keyboard or mouse. To answer a call, you simply 
click a button. Instead of holding a telephone receiver to hear and speak 
to callers, you wear a headset.

Designed to work with IP-based phone systems, the IP Softphone 2050 
provides Voice Over IP (VoIP) services using a telephony server and your 
company’s Local Area Network (LAN). 

The server that supports your IP Softphone 2050 determines what 
features you can access. For example, Call Conference, Call Transfer, 
and Call Forward.

Features

The IP Softphone 2050 supports the following features:

• 12 programmable feature keys: 6 Programmable Line 
(DN)/Feature Keys (self-labeled) and six lines/features accessed by 
pressing the shift key

• 4 soft keys (self-labeled) that provide access to a maximum of 10 
features

• multi-field display

• directory capabilities that are stored locally on your PC or linked to 
external directories such as LDAP, Microsoft Outlook, and ACT! 
contact management software

• Personal Directory, Redial List, Callers List, and Password 
Administration, stored on the application server for systems running 
CS 1000 Release 4.5 software

• one-click direct dialing from various windows and applications

• 6 specialized fixed keys:

— DN/Feature Tray selection

— Directory
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— Inbox (Message)

— Shift

— Services

— Expand to PC 

• dedicated call processing keys: 

— Hold

— Goodbye

— Answer

— Volume

— Mute

— Navigation

— Message waiting

• user-selectable ringer that enables the PC speakers or the headset to 
ring for incoming calls

• macro functions for programming lengthy dialing patterns

Main parts

The IP Softphone 2050 consists of four main parts: 

• “The Call Control window” on page 10

• “The Local Directory window” on page 11

• “The i2050srv application” on page 11

• “The System Tray icon and menu” on page 11

The Call Control window
The IP Softphone 2050 Call Control window displays the line keys, 
feature buttons, and call display. Use this window to make and manage 
your telephone calls. You also use this window to access your Network 
Directory (if one is available), the Personal Directory, Redial List, and 
Callers List features which include Application Server Administration and 
Password Administration, and your Local Directory. For more information 
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on the Call Control window see “IP Softphone 2050 Call Control window” 
on page 12.

The Local Directory window
This window enables you to create, manage, and use a telephone 
directory stored on your computer.

The i2050srv application
The i2050srv application is the software on your computer that enables 
the IP Softphone 2050 to communicate with the communication server 
you are connected to. This application is launched when you start your 
computer, but remains “hidden” in the background. To verify that it is 
running, open the Windows Task Manager.

The System Tray icon and menu
You can right-click the Softphone icon, located in the System Tray, to 
make and manage calls.
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IP Softphone 2050 
Call Control window

The IP Softphone 2050 has two Call Control windows: Standard and 
Enhanced. Both windows contain common elements that provide access 
to the IP Softphone 2050 features.

Note: The Enhanced Call Control window is the default when you 
start the IP Softphone 2050 for the first time. You can modify the 
settings so that the Standard Call Control window appears on startup 
instead.

To open the IP Softphone 2050 Call Control window:

1. From your Desktop PC, click Start. 

2. Select Programs.

3. Select Nortel Networks IP Softphone 2050.

To open the IP Softphone 2050 Standard Call Control window from the 
Enhanced Call Control window:

1. Click File.

2. Click Select Skin.

3. Click Standard.

To access the Enhanced Call Control window from the Standard Call 
Control window:

1. Click Application Menu.

2. Click Select Skin.

3. Click Enhanced. 



IP Softphone 2050 Call Control window

13

Standard Call Control window

The Standard Call Control window (shown in Figure 1) includes the 
standard features that enable you to make and manage telephone calls.

The elements of the Standard Call Control window are described in 
Table 1 on page 16.

Figure 1: Standard Call Control window
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Enhanced Call Control window

The Enhanced IP Softphone 2050 Call Control window (shown in 
Figure 2 on page 15) includes the enhanced features that enable you to 
make and manage telephone calls. The Enhanced Call Control window is 
also known as the Primary User Interface.

The elements of the Enhanced Call Control window are described in 
Table 1 on page 16.

To open the Enhanced Call Control window from the Standard Call 
Control window:

1. On the Standard Call Control Window click Application.

2. Click Select Skin.

3. Click Enhanced.

To change the information that appears on the window:

1. Click Trays.

2. Click one of the following:

— lines

— number

— combo
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Figure 2: Enhanced Call Control window
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Call Control window elements and functions

Table 1 describes the elements and functions of both the Standard and 
Enhanced Call Control windows.

Table 1: IP Softphone 2050 components and functions 
(Part 1 of 4)

Element Function

Application To access the Application menu.

Message Waiting 
light

Flashes when a message is waiting.

Primary display To provide call information (such as Caller ID) 
and instructions for using certain soft key 
features. When the telephone is idle, only the 
date and time are displayed.

Soft keys To provide access to programmable functions. 
Four soft-labeled feature keys are available: 
Transfer for connecting calls to other people, 
Conference for group calls, Forward, and 
More... for accessing additional features.

To select a feature, click the appropriate soft key 
button, and then follow the instructions on the 
display.

The soft key features that are available vary, 
depending on:

• Your current task. The features available at 
any time depend on your current call activity.

• The features that are available on your 
server. Much of the functionality of the 
IP Softphone 2050 is dependent on the 
communication server configuration.

Note: If more than four features are 
available, click the More soft key to see 
them.
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Show Lines To change the tray on the Call Control window 
(show or hide the Line buttons).

Copy To copy a network service, feature, or folder.

Quit To quit a network service or feature.

Navigation arrows To scroll through menus and lists in the display 
area.

Volume To increase or decrease the headset volume.

Mute To listen to the receiving party without 
transmitting. Click the Mute button again to 
return to a two-way conversation. The Mute 
button mutes the Headset microphone. 

Answer/Handsfree To answer and make calls.

Hold To place an active call on hold. 

The feature key label for the held line displays a 
flashing icon to indicate that the call is on hold. 
Return to the call by clicking the Line button of 
the call on hold.

Goodbye To terminate an active call.

Line keys To access one of six programmable Line keys 
that can represent line appearances, DNs, or 
features. The communication server provides the 
labels that appear on these keys.

Dialpad To dial a telephone number. Simply click the 
numbers you want to enter.

The following Standard toolbar elements apply to the Standard 
Call Control window ONLY.

Inbox/Messages To access your messages or return a call.

Table 1: IP Softphone 2050 components and functions 
(Part 2 of 4)

Element Function
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Outbox/Shift To toggle between feature key displays.

Directory To access a Network Directory. 

Depending on how your system administrator 
has set up this service, this button provides 
access to one of the following: Local Directory, 
Personal Directory, Redial List, Callers List 
features, or some other server-based directory 
service. You can use the Directory to place a call. 
The call is placed on your prime line unless you 
select a different line.

Services To access a list of network services.

Open To open a network service, feature, or folder.

Copy To copy a network service, feature, or folder.

Quit To quit a network service or feature.

The following Network Services toolbar elements apply to the 
Enhanced Call Control window ONLY.

Tray Menu List To scroll through an opened directory menu.

Directory To access a directory such as the Personal 
Directory, with up to 100 entries, or Network 
Directory. 

Depending on how your system administrator 
has set up this service, this button provides 
access to one of the following: Local Directory, 
Personal Directory, Redial List, Callers List 
features, or some other server-based directory 
service.

Inbox/Messages To access your messages or return a call.

Outbox/Shift To toggle between feature key displays.

Table 1: IP Softphone 2050 components and functions 
(Part 3 of 4)

Element Function



IP Softphone 2050 Call Control window

19

Hot keys

Within the Call Control window, the computer keyboard provides hot keys 
to access common features:

• Enter – Answer a call.

• F12 – Release or terminate a call.

• Esc – Release or terminate a call.

• F5 – Put call on hold.

Services To access a list of network services.

Open To open a network service, feature, or folder.

Next Toolbar To display the next toolbar.

The following Local Directory Quick Access toolbar elements 
apply to the Enhanced Call Control window ONLY.

Previous Toolbar To display the previous toolbar.

Quick Dials To open the list of contacts stored in the 
Quick Dials section of the Local Directory.

Redial List To open the list of up to 20 of the last calls you 
made.

Callers List To open the list of up to 100 of the calls you have 
received.

Local Directory To open the Local Directory.

Show Lines To change the tray on the Call Control Window 
(show or hide the line buttons).

Copy To copy a network service, feature, or folder.

Quit To quit a network service or feature.

Table 1: IP Softphone 2050 components and functions 
(Part 4 of 4)

Element Function
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• F1 to F4 correspond to the soft keys 1 to 4.

• Alphabetic keys map to numbers like dialpad mapping.

• Arrow keys are equivalent to the navigation keys.

• Alt-V can be used to paste data into the interface. (For example, you 
can copy a phone number from an application and paste it into the 
IP Softphone 2050 interface using the Alt-V key combination.)

Local Directory

The IP Softphone 2050 Local Directory enables you to store a phone 
directory on your computer and link to external directories. It also enables 
you to filter directories so they are easier to use.

Note: Do not confuse the IP Softphone 2050 Local Directory with the 
Network Directory that you can access by clicking the Directory 
toolbar button.

To open the Local Directory:

1. Click Application Menu.

2. Click Local Directory.

3. Click one of the following:

— Local Directory

— View Local Directory 

Note: You can also click the Local Directory icon on the Enhanced 
Call Control window toolbar.

The Shortcut Bar on the left side of the Local Directory lets you access 
groups and directories. Groups enable you to organize your directories. 
A group is represented by a button on the Shortcut Bar. Directories 
appear as icons inside groups.

To select a group, click its button. By default, the Local Directory has two 
groups: Main and Quick Dials.
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Main Group
Click the Main Group button to access the following three options:

• Local Directory - A list of your Main Directory contacts

• Redial List - A list of the last telephone calls you made

• Callers List - A list of the calls you have received

Quick Dials group
Click the Quick Dials button to see the contacts stored in the Quick Dials 
group.

Personal Directory, Redial List, and 
Callers List 

Personal Directory, Redial List, and Callers List are features supported on 
CS 1000 systems running CS 1000 Release 4.0 software. The contents 
of these directories are maintained in a remote, central database called 
the Application Server. 

To open Personal Directory, Redial List, or Callers List:

1. Click the Directory button.

2. Scroll through the following list and click to select:

— Personal Directory

— Callers List 

— Redial List 

— Password Administration 

Note: The Personal Directory, Redial List, and Callers List features 
have a one-minute time-out control period. If the application is idle for 
one minute during any of the operations, the list is closed and your 
IP Softphone 2050 returns to the idle state.

Personal Directory
Click Personal Directory to access a personalized directory, stored on 
the application server, where you can enter up to 100 contacts. 
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Callers List
Click Callers List to access a list of the last 100 incoming calls.

Redial List
Click Redial List to access a list of the last 20 numbers you have dialed. 

Password Administration
Click Password Administration to turn password protection on/off, or to 
change the password. 

For more information on the Personal Directory, Redial List, and Callers 
List, see “Personal Directory, Redial List, and Callers List” on page 60

Application Server Administration
This feature is available for your system administrator. The Personal 
Directory, Redial List, and Callers List features use a separate, central 
database, called the Application Server, to store directory data and user 
profile options. Backup and restoration of the database can be performed, 
and user profiles can be managed, by your system administrator using 
the Application Server Administration feature. 

System Tray icon and menu

The IP Softphone 2050 System Tray enables you to manage your phone 
calls and messages without opening the main IP Softphone 2050 window. 

If the IP Softphone 2050 window is minimized on the Taskbar, click either 
the IP Softphone Taskbar icon or the System Tray icon to view it. 

Right-click the System Tray icon to open a pop-up menu that enables 
you to make, answer, or manage your calls.
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Installing and setting up the 
IP Softphone 2050

System requirements

To use the Nortel IP Softphone 2050, you need:

• Pentium-compatible CPU (200 MHz or higher)

• 128 Mbytes RAM (Microsoft Windows 2000)

• 64 Mbytes RAM (Microsoft Windows 98)

• 55 Mbytes free hard drive space (all languages)

• 800X600 resolution monitor (16-bit color)

• Universal Serial Bus (USB) port

• Nortel USB Audio Kit

Supported operating systems
To use the IP Softphone 2050 you must have one of the following 
operating systems:

• Microsoft Windows XP

• Microsoft Windows 2000 Professional

• Microsoft Windows 2000 Professional Service Pack 1

• Microsoft Windows 2000 Professional Service Pack 2

• Microsoft Windows 98

• Microsoft Windows 98 Second Edition

USB Audio Kit
You must have a Nortel USB Audio Kit to use the Softphone. 
The USB Audio Kit enables you to hear and speak with your callers.

The USB Audio Kit includes:

• USB Headset Adapter
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• Installation Guide (English and French)

• USB cord

• Telephony-grade monaural headset

• Lower cordset with quick disconnect

Installing the IP Softphone 2050

Refer to IP Phones: Description, Installation, and Operation (553-3001-
368) or consult your system administrator.

Installing the USB Headset Kit

Follow these steps to install the USB Headset Kit:

1. Ensure that you have the proper system requirements as listed in 
“USB Audio Kit” on page 23.

2. Ask your system administrator to change settings, if necessary, to 
allow you to connect the IP Softphone 2050 to the communication 
server.

3. Connect the coiled lower cord to the headset cord with the Quick 
Disconnect connector. Ensure the Quick Disconnect is securely 
fastened.

4. Connect the headset cord to the RJ9 jack on the adapter.

5. Connect the USB cable to the headset adapter and to one of the USB 
jacks on the back of your computer or USB hub.

The first time the headset adapter is plugged in, a delay occurs while the 
Windows operating system configures the device and locates appropriate 
driver software. If the installation software asks for it, insert the original 
Windows CD-ROM so that the Windows operating system can locate 
drivers.

For more information on installing the IP Softphone 2050 software, 
contact your system administrator.
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Managing contacts with the 
IP Softphone 2050

The following options are available for contact management:

• “Adding contacts” on page 25

• “Editing contacts” on page 27

• “Deleting contacts” on page 28

• “Finding contacts” on page 29

• “Filtering a directory” on page 30

• “Dialing from the Local Directory” on page 30

• “Dialing from the Personal Directory” on page 31

• “Dialing from the Redial List” on page 31

• “Dialing from the Callers List” on page 32

• “Adding a group to the Shortcut Bar” on page 32

• “Customizing the Shortcut Bar” on page 33

• “Using the Properties dialog box” on page 33

Adding contacts

You can add contacts to the Local Directory in the Main Group, or to any 
group on the Shortcut Bar.

To add contacts to the Local Directory:

1. Do one on the following: 

— Click the Main Group and click the Local Directory.

— Click the Group in the Shortcut Bar you want to add contacts to. 
You can click Main, Quick Dials, or any custom group that you 
created.

2. Click File > New Contact... or click the New Contact toolbar button. 
The Properties dialog box appears.
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3. On the Business tab (which is selected by default), enter the 
contact’s name, address, telephone numbers, and other personal 
information.

4. Select the e-mail address tab and enter the contact’s e-mail 
address.

5. Select the Notes tab and enter notes or miscellaneous information.

6. Select the Settings tab and select the contact’s default telephone 
number and assign multimedia (sound and graphic) call 
announcements.

7. Click Save.

Note 1: You cannot add contacts to external directories, such as an 
LDAP directory in Local Directory mode.

Note 2: If the contents of an external directory has changed, you 
must update the directory before you can see the changes in the 
IP Softphone 2050 Local Directory. To update the directory, right-
click the imported directory and then click Refresh.

To add contacts to the Personal Directory:

1. Click the Directory button.

2. Click Personal Directory.

3. Click the Add key to start a text editor.

4. Enter the contact information. 

Note: You can click the Pause softkey at any time during data entry 
to add a pause in the number.

5. Click Done to submit the entry. 

Note 1: Unlike the Local Directory, the Personal Directory is stored 
on the Application Server. 

Note 2: You can also add contacts to the Personal Directory by 
copying entries from the Corporate Directory, the Redial List, the 
Callers List, or other available directory applications. If you are 
creating multiple entries in the Personal Directory, you can make and 
edit multiple copies in an existing entry.
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Editing contacts

You can edit contacts in all of your directories.

To edit contacts in the Local Directory:

1. On the Call Control window click, Application menu.

2. Click Local Directory.

3. Click one of the following:

— Local Directory 

— View Local Directory

4. Find and click the contact you want to edit.

5. Do one of the following:

— Click File > Properties.

— Click the Properties toolbar button.

6. Select each tab and edit the information.

7. Click Save.

To edit contacts in the Personal Directory:

1. Click the Directory button.

2. Select Personal Directory from the Directory list.

3. Search for the desired entry.

4. Highlight the entry.

5. Click the Edit soft key and make the changes.

6. Click the Done soft key.

To make temporary edits to contacts:

Use this option to temporarily edit contacts in the Redial List and the 
Callers List, then dial the edited entry. The changes are not retained. 

1. Click the Directory button.

2. Select Redial List or Callers List from the Directory list.
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3. Search for the desired entry.

4. Highlight the entry.

5. Click the Edit soft key and make the changes.

6. Click the Dial soft key to dial the edited entry.

Deleting contacts

You can delete contacts from any of your directories.

To delete a contact from the Local Directory:

1. On the Call Control window, click Application.

2. Click Local Directory. 

3. Click one of the following:

— Local Directory 

— View Local Directory 

4. Find and click the contact you want to delete. 

Note: To delete a range of contacts, click the first contact in the range 
and then shift-click the second contact in the range. You can also 
CTRL-click to select contacts.

5. Click File.

6. Click one of the following:

— Delete 

— the Delete toolbar button.

7. Click Yes to confirm the deletion.

To delete a contact from the Personal Directory, Redial List, or Callers 
List:

1. Click the Directory button.

2. Select the Personal Directory, Redial List, or Callers List.

3. Search for the entry.

4. Highlight the entry.
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5. Click the Delete soft key.

6. Click the Confirm or Cancel key.

To delete the entire Redial List or Callers List:

1. Click the Directory button.

2. Select Redial List or Callers List.

3. Click the Del soft key.

4. Click Yes.

Finding contacts

You can search for contacts in your Local Directory using any of the edit 
creation criteria.

To find a contact in one of your directories:

1. On the Call Control window, click Application.

2. Click Local Directory.

3. Click one of the following:

— Local Directory

— View Local Directory

4. Find and click the directory you want to search in.

5. Click File.

6. Click one of the following:

— Find Contact... 

— Find Contact toolbar button.

7. Enter your search criteria. 

Note: You can enter the name, e-mail address, or phone number. 
Remember to enter it the way it appears in the directory. For 
example, the name format is: “last name, first name.”

8. Click Find Now. The dialog box expands to display a list of the 
contacts that fit your search criteria.
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9. To stop a search, click Stop.

To find contacts in Personal Directory, Redial List, or Callers List:

1. Click the Directory button.

2. Click the desired directory and do one of the following:

— Scroll through the directory to the desired entry. 

— Enter the number of the entry to go directly to it.

— Search by first name, last name, or number.

Filtering a directory

The IP Softphone 2050 directory enables you to filter directories. Filtering 
makes directories smaller and easier to manage and use. This feature is 
especially useful for dealing with large, cumbersome directories; by 
filtering a directory you can greatly reduce the number of names you have 
to search through.

To filter a directory:

1. Select the directory you want to filter in the Shortcut Bar.

2. Click the Filter toolbar button. The Filter dialog box appears.

3. Add your filter criteria.

4. Click OK.

Dialing from the Local Directory

To call a contact stored in the Local Directory:

1. On the Call Control window, click Application.

2. Click Local Directory.

3. Click one of the following:

a. Local Directory 

b. View Local Directory.
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4. Locate the contact you want to call, then do one of the following:

— Double-click the phone number you want to dial.

— Double-click the contact's name. 

— Click the Call Contact toolbar button to dial the default telephone 
number.

— Right-click the contact's entry and click the desired telephone 
number in the pop-up menu.

— Click the arrow beside the Call Contact toolbar button and click 
the desired telephone number in the pop-up menu.

Dialing from the Personal Directory

To dial from the Personal Directory:

1. Click the Directory button.

2. Scroll to the Personal Directory.

3. Click to open the Personal Directory.

4. Find the contact by one of the following:

— Scroll to the desired contact.

— Search for the contact by name or number.

— Enter the number of the contact to find it.

5. Double-click the contact to dial the selected entry.

Dialing from the Redial List

To dial from the Redial List:

1. Do one of the following to open Redial List:

— Click Redial List on the Toolbar in the Enhanced Call Control. 
window.

— Click the Directory button, and click Redial List.

2. Find the contact by one doing of the following:
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— Scroll to the desired contact.

— Search for the contact by name or number.

— Enter the number of the contact to find it.

3. Double-click the contact to dial the selected entry.

Dialing from the Callers List

You can dial from the Callers List:

1. Do one of the following to open Callers List:

— Click Callers List on the Toolbar in the Enhanced Call Control 
window.

— Click the Directory button and click Callers List.

2. Find the contact by one doing of the following:

— Scroll to the desired contact.

— Search for the contact by name or number.

— Enter the number of the contact to find it.

3. Double-click the contact to dial the selected entry.

Adding a group to the Shortcut Bar

You can add a group to the Shortcut Bar in your Local Directory.

To add a new group to the Local Directory:

1. Right-click a blank area on the Shortcut Bar.

2. Click Add New Group. A blank Group button appears with a blinking 
cursor at the bottom of the Shortcut Bar.

3. Enter the name you want for the group and press Enter.

Click a group’s button to view the contents of the group.
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Customizing the Shortcut Bar
You can customize the Shortcut Bar’s appearance and icon size.

To change the size of the Directory icons:

1. Right-click a blank area of the Shortcut Bar.

2. Click one of the following: 

— Large Icons 

— Small Icons

To change the appearance of the Shortcut Bar:

1. Right-click a blank area in the Shortcut Bar.

2. Click Properties. The Shortcut Bar properties dialog box appears.

3. Enter your custom settings.

4. Click OK.

Using the Properties dialog box

Use the Properties dialog box to enter or change contact information.

To open the Properties dialog box:

1. On the IP Softphone 2050 window, do one of the following: 

— Click Application menu > Local Directory > Local Directory.

— Click View > Local Directory. The Directory opens.

2. In the Local Directory window do one of the following:

— Click File > New Contact... 

— Click the New Contact toolbar button. 

— Click a contact and click File > Properties...

— Click the Properties toolbar button.

This dialog box contains four tabs:

• “Properties - Business tab” on page 34
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• “Properties - Email Address tab” on page 34

• “Properties - Notes tab” on page 34

• “Properties - Settings tab” on page 34

Properties - Business tab
Use this tab to store a contact’s name, address, company information, 
and telephone numbers. To create a contact record, enter the contact’s 
name and at least one telephone number. All other information is 
optional.

Note: Inserting a comma in the telephone number inserts a 
0.5-second delay before dialing the numbers that follow the commas. 
Insert as many commas as required.

Export button
This button exports the contact information to a *.vcf file. This file can then 
be imported into e-mail or contact manager applications, or other software 
applications that use the *.vcf file format.

Properties - Email Address tab
Use this tab to store e-mail information:

• Email address - Enter the contact’s e-mail address.

• Email type - Enter a label for the e-mail address. For example, 
“Personal e-mail account.”

Note: You cannot send e-mail using the IP Softphone 2050.

Properties - Notes tab
Use this tab to record miscellaneous information about a contact. You can 
enter significant dates, recent orders, meeting locations, or any 
information you need to be available when you call the contact.

Properties - Settings tab
Use this tab to select which telephone number you dial by default. The 
Default Dial telephone number setting you specify here applies only to 
this contact.
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Note: You can dial a contact’s non-default telephone number by 
right-clicking the contact and selecting any other telephone number 
that appears in the pop-up menu.
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Managing IP Softphone 2050 calls

Making telephone calls

Before making a call, ensure that you are wearing your headset.

To make a call:

1. Select the line you want to use by clicking a Line key.

2. Choose one of the following methods to enter the phone number:

— Enter the phone number using the number pad on your keyboard. 

— Use the mouse and the IP Softphone 2050 dial pad.

— Open a directory application, such as Personal Directory, Redial 
List, or Callers List, scroll through the directory, and double-click 
the number you want to dial.

Note: To make a call on your prime telephone line, click the 
Answer/Handsfree button and dial the telephone number as 
described above.

Answering telephone calls

Before answering a call, ensure that you are wearing your headset. When 
you receive a call, you hear the IP Softphone 2050 ringer through the 
Ringing Speaker and you see Caller ID (if available) on the display area.

Note: The Ringing Speaker is the device you specify on the Select 
Sound Devices screen of the Configuration Utility.

To answer a call:

• Do one of the following:

— Click the Answer/Handsfree button.

— Click the Line key of the ringing line.

 If you are on another call, that call is put on Hold.
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Note: To switch between callers, click the appropriate Line key.

Holding and retrieving telephone calls

Before using the phone, ensure that you are wearing your headset.

To put a call on Hold, or retrieve a call from Hold:

1. Click the Line key for the call.

2. Click the Hold button.

Hanging up telephone calls

You must terminate a call when it has ended.

To hang up a telephone call:

1. Click the appropriate Line key to ensure it is selected.

2. Click the Goodbye/Release key.
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IP Softphone 2050 USB Headset 
Adapter 

You must install a Nortel USB Audio kit before using the 
IP Softphone 2050. See “Installing the USB Headset Kit” on page 24.

Overview

The features of the USB Headset Adapter are described in Table 2.  

Table 2: USB Headset Adapter elements and functions (Part 1 of 2)

Element Function

Message Waiting 
light

The red Message Waiting light is located at the 
top of the USB Headset Adapter. This light has the 
same function as the Message Waiting light on the 
IP Softphone 2050 interface.

This light flashes when you have voicemail 
messages. On most systems, this light also 
flashes when a call is ringing on the 
IP Softphone 2050.

Maximize button Press the Maximize button to maximize or 
minimize the IP Softphone 2050. 

If the IP Softphone 2050 is minimized, press this 
button to maximize the IP Softphone 2050 
window. 

If the IP Softphone 2050 is maximized, but behind 
another window, press this button to bring the 
IP Softphone 2050 to the foreground. 

If the IP Softphone 2050 is maximized, press this 
button to minimize the IP Softphone 2050.
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i2050 Smart 
Functions button

Press this button to access the i2050 Smart 
Functions menu. For more information about the 
i2050 Smart Functions menu, refer to “Using the 
i2050 Smart Functions menu” on page 41.

Answer button If you have an incoming call, press the Answer 
button to answer the call. 

If you have no incoming call when you press this 
button, the IP Softphone 2050 selects a line and 
you hear a dial tone.

Release button Press the Release button to hang up the current 
call.

Mute button Press the Mute button to mute a call. When you 
mute a call, you can still hear your caller, but your 
caller cannot hear you. Press the Mute button a 
second time to resume your conversation. 

Mute light The Mute light is beside the Mute button. When a 
call is on mute, the Mute light is on. When a call is 
not on mute, the Mute light is off.

Volume button Use the Volume button to control the volume of 
the headset.

When the i2050 Smart Functions Menu appears, 
use these buttons to move up and down in the 
menu.

Table 2: USB Headset Adapter elements and functions (Part 2 of 2)

Element Function



IP Softphone 2050 USB Headset Adapter

40

Answering calls with the USB Headset 
Adapter

You can answer a call using the USB Headset Adapter even if the 
IP Softphone 2050 is minimized or in the background. 

To answer a call using the USB Headset Adapter:

1. Ensure that you are wearing your headset.

2. Press the Answer button.

To view Caller ID information before you answer the call if 
IP Softphone 2050 is minimized or in background:

1. Ensure that you are wearing your headset.

2. Press the Maximize button to display the IP Softphone 2050 
interface.

3. Press the Answer button. 

Hanging up calls with the USB Headset 
Adapter

You can hang up a call using the USB Headset Adapter even if the 
IP Softphone 2050 is minimized or in the background. 

To hang up a telephone call using the USB Headset Adapter, press the 
Release button.

Adjusting the volume with the USB Headset 
Adapter

You can easily adjust the volume of your telephone calls using the USB 
Headset Adapter. Ensure that you are wearing your headset so you can 
hear the changes as you make them.

To decrease the volume, press the left side of the Volume button. 

To increase the volume, press the right side of the Volume button. 
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Muting a call

When you mute a call, you can still hear your caller, but your caller cannot 
hear you.

To mute a call using the Headset adapter, press the Mute button.

Using the i2050 Smart Functions menu

The i2050 Smart Functions menu provides quick access to 
IP Softphone 2050 features. You can customize what appears on this 
menu using the i2050 Configuration Utility.

To access the i2050 Smart Functions menu:

1. Press the i2050 Smart Functions button on the USB Headset 
Adapter.

2. Highlight the feature you want by using one of the following:

— the mouse

— the keyboard arrow keys

— the Volume button on the USB Headset Adapter 

3. To select the feature, do one of the following:

— Click the OK button.

— Press the i2050 Smart Functions button on the USB Headset 
Adapter.

If the i2050 Smart Functions menu displays only one feature, the 
Don't display this dialog again check box appears. If you select this 
check box, the i2050 Smart Functions menu does not appear when you 
press the i2050 Smart Functions button. Instead, the feature on the 
i2050 Smart Functions menu is automatically executed when you press 
the i2050 Smart Functions button.
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Customizing the i2050 Smart Functions 
menu

You can customize the features that appear on the i2050 Smart Functions 
menu using the i2050 Configuration Utility. 

To customize the i2050 Smart Functions menu:

1. Click the Start button. 

2. Click Settings.

3. Click Control Panel.

4. Double-click the IP Softphone 2050 icon.

5. Click the USB Headset Adapter tab.

6. Click the Configure Smart Functions button. 

7. Click the OK button to close the Configure Smart Functions dialog 
box.

8. Click the OK button to close the i2050 Configuration Utility.

Use the procedures below to change the functions that are available.

To add a function:

1. On the Available functions list, click the function you want to add.

2. Click the Add button.

3. Click the OK button to close the Configure Smart Functions dialog 
box.

4. Click the OK button to close the i2050 Configuration Utility.

To remove a function:

1. Click the function you want to remove.

2. Click the Remove button.

3. Click the OK button to close the Configure Smart Functions dialog 
box.

4. Click the OK button to close the i2050 Configuration Utility.
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To rearrange the functions on the menu:

1. Click the function you want to move up or down on the i2050 Smart 
Functions menu.

2. Do one of the following:

— Click the Move Up button to move the function to a higher 
position on the menu.

— Click the Move Down button to move the function to a lower 
position on the menu.

You can also add special functions to the i2050 Smart Functions menu. 
For information about adding special functions, refer to Custom Functions 
for i2050 Smart Functions menu.

Custom Functions for i2050 Smart Functions 
menu

From the Configure Smart Functions dialog box, you can add, delete, and 
modify custom functions on the i2050 Smart Functions menu.

To add a custom function:

1. Click the New button.

2. In the Name box, enter the name you want to appear on the i2050 
Smart Functions menu.

3. In the Command box, enter the pathname and file name of the 
function you want to add.

Note:  If you do not know the pathname or file name of the function, 
click the Browse button beside the Command box. You can then 
navigate to the correct file, select it, and click the Open button.

4. In the Arguments box, enter any arguments that are required for this 
function.

Note: If you want the IP Softphone 2050 to prompt you for the 
argument when you select this special function, select the Prompt 
for arguments check box.
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5. In the Initial directory box, enter the pathname of the directory you 
want this function to use. 

Note: If you do not know the pathname of the directory, click the 
Browse button beside the Initial directory box. You can then navigate 
to the correct directory, select it, and click the OK button.

6. To change the icon that appears beside this function on the i2050 
Smart Functions menu, click the Change icon and perform steps 7 to 
9. If you do not want to change the icon, go to step 10.

7. Click the Browse button.

8. Navigate to the file you entered in the Command box and select it.

9. Click the Open button.

10. Click one of the icons that appears.

11. Click the OK button.

12. Click the OK button to add the new function to the i2050 Smart 
Functions menu.

To modify a custom function:

1. Click the custom function you want to modify.

2. Click the Modify button.

3. Make the required changes.

4. Click the OK button.

To remove a custom function:

1. Click the custom function you want to remove.

2. Click the Delete button.

3. Click the Yes button to confirm the deletion.
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IP Softphone 2050 macros

About macros with the IP Softphone 2050

The IP Softphone 2050 enables you to record macros. A macro is a 
recorded sequence of steps that can be used to automate repetitive 
actions. For example, you can program a macro that selects a particular 
telephone line and then dials a telephone number automatically or a 
macro that ensures a certain number is always dialed out on a particular 
telephone line.

To access the IP Softphone 2050 Macro menu from the Standard Call 
Control window, click the Macro menu. 

To access the IP Softphone 2050 Macro menu from the Enhanced Call 
Control window, click Application menu > Macro.

Once you have recorded a macro, it is saved under the Macro menu.

Recording a macro

You can record a macro to automate a procedure or repetitive action.

To record a macro:

1. Click the Macro button.

2. Click New.

3. Enter the name of your new macro.

4. Click Record.

5. Enter the keystrokes to complete the action or procedure.

6. Click Add to add the new macro to the macro list.

Note: You can insert a short pause in the macro by using the Pause 
key. A pause introduces a delay, which is required to access some 
Interactive Voice Response applications and the voicemail systems.
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Note: If you wish to cancel recording a macro, click the Abort button 
at the bottom of the Call Control window.

Deleting a macro

You can delete a macro by recording a new macro over the existing one.

Playing a macro 

You can play macros to dial telephone numbers or access your voicemail. 

To play a macro, do one of the following:

• Click Macro > [Macro name].

• Click Application menu > Macro > [Macro name].
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IP Softphone 2050 menu 
commands 

Enhanced Call Control window menu

The Application menu provides access to the Enhanced Call Control 
window.

To access the Enhanced Call Control window:

1. Click Application Menu.

2. Select Skin.

3. Select Enhanced. 

The following selections are available in the Enhanced Call Control 
window menu:

• Trays – Selects the information that appears on the Enhanced Call 
Control window.

— Retract Tray - Displays no additional information, so the 
Enhanced Call Control window takes up less space.

— Lines - Displays the Line keys in two columns.

— Number Pad - Displays the dialpad.

— Combo - Displays the Line keys and the dialpad.

• Configure Audio – Specifies the sound device you want to use with 
the IP Softphone 2050. A sound device such as the USB Audio Kit 
enables your computer to send and receive audio (sound) signals.

• Select Skin – Selects a Call Control window: Standard or Enhanced.

• Select Language – Selects the language that is used on the 
IP Softphone 2050.

• Local Directory – Opens the Local Directory.

• Redial List - Opens the Redial List.

• Callers List - Opens the Callers List.
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• Macro [Name] – Executes the macro that you saved in this 
command.

• Record – Starts recording a macro.

• Help – Opens the IP Softphone 2050 Help window.

• About – Displays information about the IP Softphone 2050.

• Exit – Closes the Call Control window, but does not disconnect your 
computer from the telephony server. You can still receive telephone 
calls (the i2050srv application remains running in the background).

Standard Call Control window menu

The Standard Call Control window menu contains the following items.

• Configure Audio – Specifies the sound device you want to use with 
the IP Softphone 2050. A sound device such as the USB Audio Kit 
enables your computer to send and receive audio (sound) signals.

• Select Skin – Selects a Call Control window: Standard or Enhanced.

• Select Language – Selects the language that is used on the 
IP Softphone 2050.

• Exit – Closes the application.

View menu

The View menu contains the following items:

• Local Directory – Displays the Local Directory.

• Message Waiting – Shows or hides the Message Waiting Light.

• Toolbar – Shows or hides the Toolbar.

• Primary Display – Shows or hides the Primary Display.

• Compact Lines – Displays the IP Softphone 2050’s Line keys in two 
columns so that the main window takes up less space.

• Numeric Pad and Lines – Displays the Dial Pad and the Line keys in 
one column.
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• System Tray – Shows or hides the IP Softphone 2050 task tray icon. 
Right-click this icon to make or manage telephone calls.

Macro menu

The Macro menu contains the following items.

• Macro [Name] – Executes the macro you saved in this command.

• Record – Starts recording a macro.

• Abort – Stops recording a macro.

Help menu

The Help menu contains the following items.

• Contents – Displays the help topics.

• Search – Searches the help topics for a word or phrase.

• Index – Displays the index for the help topics.

• What's This? – Activates Context Sensitive Help. After selecting this 
command, click any area of the screen to see help information about 
it.

• About – Displays information about the IP Softphone 2050.
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Troubleshooting the 
IP Softphone 2050

Application interoperability issues

Some applications do not properly check versions of shared system files 
at installation time. This can cause interoperability problems between the 
IP Softphone 2050 and other applications.

For example, installing Timbuktu version 2.0 for Windows 2000 
overwrites a .dll file that is also used by the IP Softphone 2050. The 
IP Softphone 2050 requires the newer version of the .dll and installs this 
newer version if necessary. To use the IP Softphone 2050 on the same 
computer as version 2.0 of Timbuktu, you must install Timbuktu first.

The IP Softphone 2050 follows Windows and Install Shield standards for 
version management of system files.

Connectivity problems

Communication Server is unreachable

Symptom:
One of the following messages appears:

• Connecting...

• Server unreachable. Reconnecting in xx seconds.

• 802.1 QoS is not supported on your network.

Description:
These messages indicate that the connection with the communication 
server cannot be established. A random retry time is set, after which the 
IP Softphone 2050 attempts to re-connect. This process is repeated until 
the IP Softphone 2050 is successfully connected.
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If the communication server is running and reachable, and the 
IP Softphone 2050 is pointed to the correct IP address, the 
“Connecting...” message appears briefly (or not at all).

The “Server unreachable” message indicates that there is a problem 
contacting the communication server.

Potential causes:
• Network is down.

• Computer is not connected to the network.

• Invalid communication server settings in the Configuration Utility.

• Invalid communication server settings in DHCP configuration.

• Communication server is down.

Action:
• Ping another station on the network.

• Ping the communication server.

• Use the Configuration Utility to verify the communication server 
IP address and port number.

• Verify that the communication server configuration is correct (a port is 
available, a license is available, security is correct). 

• In the IP Softphone 2050 Configuration Utility QoS tab, select Off, 
then restart the IP Softphone 2050 application.

Connection is reinitializing

Symptom:
The following message appears: “Connection Established. 
Reinitializing...”

Description:
This message indicates that the IP Softphone 2050 has established a 
connection and has sent a request to the communication server to 
resume connection. The communication server is expected to reply to this 
request. Some communication servers pass the IP Softphone 2050 to 
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different sub-components, causing this message to appear two or three 
times in rapid succession during a normal startup.

Potential causes: 
• If the message appears briefly, this is part of a normal startup.

• If the message persists, a programming error in the communication 
server is indicated.

Action: 
Wait to ensure that this message is not a transient startup message. If the 
message still appears, ensure that your communication server 
programming is correct.

Authorization failed

Symptom:
The following message appears: “Authorization failed”.

Description:
Client has not been authorized to use the communication server. 

Potential causes: 
• The client has not been authorized by your system administrator. 

• The HardwareID in your configuration (Configuration Utility) does not 
match the HardwareID provisioned for the communication server.

Action: 
Contact your system administrator.

Unable to retrieve communication server 
parameters from DHCP server

Symptom:
The following message appears:“DHCP server is not available”.

Description:
A connection with the DHCP server cannot be established.
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Potential causes:
• Network is down

• DHCP server configuration error

Action: 
Contact your system administrator.

Service denied

Symptom:
The following message appears:”Service Denied. Reason XXXX “.

Description:
You are not authorized to use the communication server. 

Potential causes: 
• Invalid HardwareID in the Configuration Utility 

• Invalid communication server configuration

Action: 
• Ensure that your communication server programming is correct.

• Contact your system administrator.

Display updates are very slow

Symptom:
• Cannot connect properly to the communication server.

• Messages written to the IP Softphone 2050 appear very slowly.

• Floppy drive is active.

Potential causes: 
The Trace utility is turned on and writing signaling information to a slow 
disk such as a floppy drive.
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Action: 
• Disable (uncheck) the Trace feature during normal operation. To 

check the status of the Trace feature, open the Configuration Utility 
and then open the Trace tab.

• If you are using the Trace feature, set the directory to a local, high-
speed disk drive.

Audio problems

Verify basic audio operation
To verify the physical connection and proper Windows audio 
configuration, record an audio message and play it back using the USB 
headset.

One-way audio
Check that the handsfree option has been programmed for the 
IP Softphone 2050 on the communication server.

Check if the mute option has been turned on. If the mute option is on, the 
Mute button appears red on the IP Softphone 2050 interface.

Check that Network Address Translation (NAT) device is used in the 
system. If so, check the NAT configuration. One-way audio occurs if the 
NAT configuration causes the IP Softphone 2050 to attempt to connect to 
the wrong IP address.

Broken or choppy speech
The Audio Quality slider adjusts the number of buffers between the 
computer audio device and the IP Softphone 2050 application. Less delay 
reduces the audio delay but increases the chances of getting broken or 
absent audio. Higher quality reduces the chance of broken audio but 
increases audio delay.

If you are receive choppy or broken speech, move the Audio Quality 
slider toward Higher Quality.
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The Windows operating system uses very high process and thread 
priorities when performing low-level Windows operations, such as 
minimizing and maximizing applications. This can cause brief breaks in 
the IP Softphone 2050 audio streams. 

To reduce the severity of this symptom, turn off the Windows transition 
effects for menus and tool tips. 

To turn off the Windows transition effects:
1. Click the Start button.

2. Click Settings.

3. Click Control Panel.

4. Click Display.

5. Select the Effects tab, (or, under Windows XP, the Effects button on 
the Appearance tab).

6. Clear the Use transition effects for menus and tool tips check box.

Other causes of audio issues
Other applications running on your computer, especially CPU-intensive 
applications or applications that intercept or delay packets (such as 
firewalls), can cause broken audio.

Multiple Ethernet interfaces on a single PC can sometimes conflict with 
each other. For example, the IP Softphone 2050 sometimes exhibits 
intermittent breaks in audio when using docked notebooks that have a 
Xircom RealPort Cardbus Ethernet 10/100+Modem 56 PC Card 
(PCMCIA) inserted. In the specific case of this PC card, the problem 
relates to a version of the Xircom driver. This driver takes CPU cycles 
even when it is not active and this, in turn, causes IP Softphone 2050 
audio to become choppy. 

Solutions for this example are:

1. Upgrade your Xircom driver.

2. Remove the PC card when the notebook is docked.
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To upgrade your Xircom driver: 

1. Download and install a new PC card driver from the Xircom web site. 

2. Follow the installation instructions provided by Xircom.

Note: You require administrator privileges on Windows 2000.

Windows sound comes out of the headset

Description:
Windows sound comes out of the headset, but you want Windows sound 
to come out of the loudspeakers and the Softphone audio to come from 
the headset.

Action:
In some cases, the Windows operating system defaults all the sounds to 
the new sound device.

If you want to use the computer speakers for playing the Windows 
sounds:

1. Click the Start button.

2. Click Settings.

3. Click Control Panel.

4. Click Sounds and Multimedia.

5. Select the Audio tab.

6. Select Sound Playback Preferred device. 

7. From the drop-down list, select your computer sound card. (Select 
your computer’s Sound Recording Preferred device as another 
device if you do not wish to use the Headset Adapter for this 
purpose.)

Advanced audio settings
Select the option Use Communication Server values. When you 
choose this option, the IP Softphone 2050 uses the jitter buffer 
parameters sent from the communication server.
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You can override these settings by selecting the Override 
Communication Server. Nortel recommends that you do not use this 
option.

Reset conditions

The IP Softphone 2050 resets when:

• instructed to do a hard reset by the communication server

• you change the IP Softphone 2050 skin

• firewall applications intercept or delay packets causing the 
IP Softphone 2050 to reset due to the expiration of the Watchdog 
timer

Note: Use care when using firewall applications on the same 
computer as the IP Softphone 2050.

• excess delay or loss of communication with the server occurs

USB Headset problems

Headset not functioning
Try the following in the order presented:

1. Verify that you have a supported operating system. To check the type 
of operating system you are using, from the PC desktop, right-click 
the My Computer icon and then click Properties.

2. Ensure that Universal Serial Bus controllers appears in the Windows 
Device Manager. If it does not appear, check to ensure that USB is 
enabled in your computer’s setup menus or check for a BIOS 
upgrade. Contact your computer supplier.
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3. Ensure that USB Audio Device appears under “Sound, video and 
game controllers” in the Windows Device Manager. Also ensure that 
HID-compliant device and USB Human Interface Device appears 
under Human Interface Devices. If they do not, and the above 
conditions are correct, see the USB Troubleshooting section in 
Windows Help.

4. Ensure that you have selected USB Audio Device as the microphone 
and speaker for the Softphone.

USB Headset Adapter features grayed out

Symptom:
All of the features on the USB Headset Adapter tab in the i2050 
Configuration Utility are grayed out.

Description:
The adapter is not recognized as a Nortel USB Headset Adapter or the 
version of the USB Headset Adapter is earlier than 2.0.

Potential causes:
1. The USB Headset Adapter does not support the functions listed on 

the USB Headset Adapter tab.

2. The USB Headset Adapter has failed to enumerate properly.

Action:
If you suspect potential cause 2, do the following:

1. Unplug the USB cable from the USB Headset Adapter.

2. Wait one minute.

3. Plug the USB cable into the USB Headset Adapter. This forces the 
USB Headset Adapter to re-enumerate. 

Cannot hear audio through headset
Ensure that the headset plugged into the USB adapter is provided by the 
manufacturer.

Check the connectors for a loose connection.
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Sound still comes out of my computer speakers

Description:
The IP Softphone 2050 is not configured to direct all call audio to the 
headset.

Action:
Configure the USB Headset by doing the following:

1. Go to the IP Softphone 2050 Call Control Window. 

2. Click Application Menu.

3. Click Configure Audio.

4. Select Headset Microphone.

5. Choose USB Audio Device from the drop-down list.

6. Choose Headset Speaker.

7. Choose USB Audio Device from the drop-down list.

8. Chose Ringing Speaker.

9. Choose the desired device from the drop-down list.

10. Click OK.

Directory problems

Redial List and Callers List must be available on your Call Server, and the 
appropriate class of service must be enabled, in order for you to use 
them. If you cannot access Redial List or Callers List contact your system 
administrator.
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Personal Directory, Redial List, 
and Callers List

Personal Directory, Redial List, and Callers List are features supported on 
CS 1000 systems running CS 1000 Release 4.5 software. The contents 
of these directories are maintained in a remote, central database called 
the Application Server. 

To open Personal Directory, Redial List, or Callers List:

1. Tap the Directory icon.

2. Make your selection from the following list.

— Personal Directory

— Callers List 

— Redial List 

— Password Administration 

Note: The Personal Directory, Redial List, and Callers List features 
have a one-minute time-out control period. If the application is idle for 
one minute during any of the operations, the application is closed and 
your IP Softphone 2050 goes back to the idle state.

The Personal Directory, Redial List, and Callers List features support:

• multiple languages

• access using the Directory key

• feature launch while in Call Transfer and Conference modes (your 
IP Softphone 2050 does not have to be idle)

• Branch Office in normal mode only

• Virtual Office

• menu-driven configuration of Station Control Password (SCPW) from 
your IP Softphone

• database backup and restoration by your system administrator

• system administrator functions, such as unlocking your SCPW
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• system administrator restoration of profiles for single, multiple, or all 
users

User preferences for Personal Directory, Redial List, 
and Callers List
You can change the following:

• language

• date/time display format

• call timer

• name display format

• call log options

— log all/unanswered calls

— area code setup

— preferred name match

— new call indication

To set user preferences:

1. Tap the Services icon.

2. Tap Telephone Options.

3. Select one of the following:

— Language

— Date/time

4. Scroll down the list.

5. Tap your selection.

6. Tap Select or Cancel.

Call Log Options
The following is a list of Call Log Options:

• Log all/unanswered incoming calls

• New call indication
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• Preferred name match

• Area code set-up

• Name display format

Table 3 describes the Call Log Options.  

Table 3: Call Log Options (Part 1 of 2)

Call Log Option Description Default value

Log all/unanswered 
incoming calls

Callers List logs all of 
the incoming calls or 
only the unanswered 
incoming calls. 

Log all calls

New call indication Telephone displays a 
message indicating that 
a new incoming call 
was received.

On

Preferred name 
match

If set to Off, the CPND 
from the Call Server is 
displayed for an 
incoming call. If set to 
On, the name stored in 
the Personal Directory 
is displayed, if a match 
is found.

Off

Area code set-up Incoming call phone 
numbers display in the 
order you set, if the 
area code matches one 
of the three that you 
have set up. Example: 
area code first or area 
code last.

No area code 
specified
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To set Call Log Options:

1. Tap the Services button.

2. Tap Telephone Options.

3. Tap Call Log Options.

4. Tap one of the following:

— Incoming Calls

— Preferred Name Match

— Area Code Setup

— Name display format

5. Scroll through the selected list.

6. Tap your selection.

7. Tap Select or Cancel.

Personal Directory
You control your own Personal Directory. You can create up to 100 
entries. You can edit, copy, or delete individual entries, or delete the 
entire list, and you can copy entries from other applications to Personal 
Directory or from Personal Directory to other applications.

The following list describes the contents of a Personal Directory entry:

• last name (up to 24 characters)

• first name (up to 24 characters

• DN at work (up to 31 characters)

Name display format You can define the 
format of the name 
displayed for incoming 
calls. The options are: 
first name/last name or 
last name/first name

First name/last 
name

Table 3: Call Log Options (Part 2 of 2)

Call Log Option Description Default value
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• DN at home (up to 31 characters

• cell phone (up to 31 characters)

• pager (up to 31 characters)

To add a contact to Personal Directory:

1. Tap the Directory icon.

2. Tap Personal Directory.

3. Tap the Add key to start a text editor.

4. Enter the contact information. 

Note: You can tap the Pause soft key any time during data entry to 
add a pause in the number.

5. Tap Done to submit the entry. 

You can also add contacts to the Personal Directory by copying entries 
from the Corporate Directory, the Redial List, the Callers List, or other 
available directory applications. If you are creating multiple entries in the 
Personal Directory, you can make and edit multiple copies of an existing 
entry.

To edit a contact in the Personal Directory:

1. Tap the Directory icon.

2. Select Personal Directory from the Directory list.

3. Search for the desired entry.

4. Highlight the entry.

5. Tap the Edit soft key and make the changes.

6. Tap the Done soft key.

You can temporarily edit contacts in the Redial List and the Callers List 
then dial the edited entry. The changes are not retained.

To dial from the Personal Directory:

1. Tap the Directory icon.

2. Scroll to the Personal Directory.
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3. Tap Personal Directory.

4. Find the contact by one of the following:

— Scroll to the desired contact.

— Search for the contact by name or number.

— Enter the number of the contact to find it.

5. Double-tap the contact to dial the selected entry.

Call Log features: Redial List and Callers List
Redial List and Callers List are Call Log features. The content of Redial 
List and Callers List is generated by the system during call processing. 
You can delete individual entries or the entire directory in Redial List and 
Callers List, but you cannot add an entry or permanently change the 
content of an entry.

Callers List
The Callers List can contain up to 100 entries. When the list is full, the 
system overwrites the oldest entry. 

In Directory View mode, the caller’s name displays along with the Callers 
List entry count. Entries in the Callers List are sorted by Call Log time. 
The first entry you see is the first new entry. If you press the down 
navigation key, more new items in the Callers List display. If you press the 
up navigation key, an older item in the list displays. 

The following list describes the contents of a Callers List entry:

• last name (24 characters)

• first name (24 characters)

• DN (31 characters)

• time/date

• number of calls
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Dialing from the Callers List
To dial from the Callers List:

1. Do one of the following to open Callers List:

— Tap the Callers List icon on the Toolbar

— Tap the Directory icon and tap Callers List.

2. Find the contact by one doing of the following:

— Scroll to the desired contact

— Search for the contact by name or number

— Enter the number of the contact to find it 

3. Double-click the contact to dial the selected entry.

Redial List
The Redial List can contain up to 20 entries. When the list is full, the 
system overwrites the oldest entry.

In Directory View mode, the number you dialed is displayed. Redial List 
content is updated when you dial out. Entries in the Redial List are sorted 
by Call Log time. The oldest entry is at the beginning of the list. Press the 
down navigation key to go to the newest entry and press the up 
navigation key to go to the oldest.

The following list describes the contents of a Redial List entry:

• user name (up to 24 characters)

• DN (up to 31 characters)

• time of the last call occurrence

• time/date

Dialing from the Redial List
To dial from the Redial List:

1. Do one of the following to open Redial List:

— Tap Redial List on the Toolbar.

— Tap the Directory icon and tap Redial List.
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2. Find the contact by one doing of the following:

— Scroll to the desired contact.

— Search for the contact by name or number.

— Enter the number of the contact to find it.

3. Double-tap the contact to dial the selected entry.

To temporarily edit a contact and dial it using the Redial List or the 
Callers List:

1. Tap the Directory icon.

2. Select Redial List or Callers List from the Directory list.

3. Search for the desired entry.

4. Highlight the entry.

5. Tap the Edit soft key and make the changes.

6. Tap the Dial soft key to dial the edited entry.

To find contacts in Personal Directory, Redial List, or Callers List:

1. Tap the Directory icon.

2. Tap the desired directory and do one of the following:

— Scroll through the directory to the desired entry. 

— Enter the number of the entry to go directly to it.

— Search by first name, last name, or number.

To delete a contact in Personal Directory, Redial List, or Callers List:

1. Tap the Directory icon.

2. Select the Personal Directory, Redial List, or Callers List.

3. Search for the entry.

4. Highlight the entry.

5. Tap the Delete soft key.

6. Tap the Confirm or Cancel key.
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To delete the Redial List or Callers List:

1. Tap the Directory button.

2. Select Redial List or Callers List.

3. Tap the Del soft key.

4. Tap Yes.

Password Administration
The Password Administration feature is available on the Directory list. 
The Station Control Password (SCPW) protects your private directory 
information. You can perform Password Administration from your 
MVC 2050 once your SCPW is defined by your system administrator on 
the Call Server. This includes turning password protection on or off and 
changing your password.

When password protection is enabled, authentication is required before 
you can access Personal Directory, Redial List, or Callers List. You are 
prompted to enter your password in order to gain access to any of the 
password-protected features, such as Personal Directory, Redial List, 
Callers List, or Virtual Office.

Note: The default setting for Password Protection is Off.

To turn Password Protection On/Off:

1. Tap the Directory icon.

2. Select Change Protection mode.

If Password Protection is enabled, you are prompted to enter your 
password.

3. Tap one of the following:

— Ent to confirm

— Del to delete your password

— Clr to clear your password

— Can to cancel and return to the Directory list
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4. If you tapped Ent, select one of the following:

— Enable Pwd Protection

— Disable Pwd Protection

5. Tap one of the following:

— Yes to accept your selection

— No to return to the Directory list

6. If you selected Yes, tap Done to enable or disable Password 
Protection.

To change your password:

1. Tap the Services icon.

2. Select Telephone Options (you are prompted to enter your 
password).

3. Enter your password.

4. Select New Password.

5. Tap one of the following:

— Sel to select New Password

— Del to return to the previous menu

— Clr to clear your password

— Can to end

If you tapped Sel, you are prompted to enter a new password.

6. Enter your new password and tap Sel. You are prompted to confirm 
your new password.

7. Tap one of the following:

— Sel to select New Password

— Del to return to the previous menu

— Clr to clear your password

— Can to end

If you tapped Sel, your password is changed.
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If you make three consecutive incorrect password attempts within an 
hour, you are locked out of the password-protected features for an hour. 
“Locked access” displays on your telephone. 

If Virtual Office is enabled, it is also locked out. If you fail to access Virtual 
Office with incorrect password attempts, your access to other password-
protected features is also locked out.

Your system administrator can reset and unlock your access at any time if 
you have been locked out or have forgotten your password.
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